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SAVE THE DATE. We’re excited to announce our 5th 

consecutive Annual Customer Conference will be at the famous 

Mission Inn landmark this year. As the attendee turnout increases 

yearly, we’re extending our conference this year to 3 days!  

 

First, we’re providing users with a chance to learn from the 

Laserfiche Institute Training on August 22nd. This is an optional 

training course held by the people from Laserfiche. Seating is 

limited to only 30 students so register soon! 

 

The 23rd is our complementary conference showcasing the newest 
industry products, our integrations, and an opportunity to network 

with industry partners.  



 

Finally, we’re holding day for you to enjoy and relax. Below you can 

find various activities complementary of ECS. We want your stay 

at our conference to be memorable. 

 

August 22: Optional Training Day 
• 8:30 a.m. – 5:00 p.m.  

• $350 per seat (seating is limited to 30 students) 
 

August 23: Complementary Conference Day 
• Training: 8:00 – 4:30 p.m. 

• Cocktail Hour: 4:30 – 5:30 p.m. 

 

Sessions Overview 
• Laserfiche 8 – General & Architectural Overview 

• Kofax Document Exchange 

• Attach Plus Email Encryption  

• Visioneer One Touch Solutions 

• ESRI 

• And many more! 

 

August 24: Complementary Activity Day 
• Historic Mission Inn Tour 

• Museum 

• Kelly’s Spa Massage  

• Riverside Fairmount Golf Outing 

 

Conference and Training Registration 
To register for the conference: 
Send your contact information to Sales@ecsimaging.com 

*Early bird registrants will receive a free tour of the Mission Inn. 

 

To register for Optional LF Institute Training: 
• Call (951)787-8768 x 103  

 

For special conference hotel rates: 
• Call (951)787-8768 x 103 

 

DEADLINES 
June 30th – deadline for free tour 

July 20th – deadline for conference hotel rates 
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Would you like ECS to 
host a User Group and 
free training session at 

your site? 
 

Just let your Sales 
Rep know. 

 

ECS 1st Quarter Workshops 
 

1. Lake Elsinore USD 
Tuesday, May 22, 2007  
8:00 a.m. – 1:30 p.m.  
Conference Center 

520 Chaney Street, Building 700 

Lake Elsinore, CA 92530 

 

2. City of Tustin  
Thursday, June 7, 2007 
9:00 a.m. – 3:00 p.m. 
Council Chambers 

300 Centennial Way 

Tustin, CA 92780 
 

* At each of our user groups we will give away one ticket to the 

Laserfiche Institute Training for August 22 ($350 value). 
 

To register: Send your contact information with the event in the 

subject line to Sales@ecsimaging.com. 

 

Webinars TOP 

Best Practices in Local Government: Capture, 
Store and Retrieve 
 

Learn how to balance the demands of capturing records 

with the need to retrieve information quickly for internal 

and public requests. 

 

Register 

Tue., May. 8, 2007  
(10:00 a.m. Pacific) 

 

Wed., May. 30, 2007  

(11:00 a.m. Pacific) 

 

Thu., Jun. 14, 2007  
(10:00 a.m. Pacific) 

Content, Convergence and Collaboration –
Laserfiche Document Management and GIS 
 

Learn how to put your spatial data together with your 

document archive to achieve a higher degree of business 

effectiveness through a smart integration of GIS and 

document management. 

 

Register 

Wed., May. 30, 2007  
(8:00 a.m. Pacific) 

 

Wed., Jun. 13, 2007  
(11:00 a.m. Pacific) 

Get the Laserfiche Edge - Share Information 
to Ensure Public Safety 
 

See how Laserfiche software integrates with CAD, RMS 

and GIS applications to create a secure digital network 

that gets the right information to the right people.  

Wed., May. 9, 2007  
(11:00 a.m. Pacific) 

 

Wed., Jun. 27, 2007  
(10:00 a.m. Pacific) 



 

Register 

Document Management 101 for Law 
Enforcement Agencies 
 

Learn how Laserfiche document management software 

streamlines processes, strengthens security and 

increases effectiveness.  

 

Register 

Wed., Jun. 6, 2007  
(11:00 a.m. Pacific) 
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Support Site 

 

Current Versions 
• Client-Server 7.2.1 

• Plus 7.2 

• WebAccess 7.2.1 

• Quick Fields 7.1.2 

• Agenda Manager 7.2 

• Audit Trail 7.2 

• Email (Mapi) 7.1 

• Integrator’s Toolkit 7.2 

• Scan Connect 7.1 

• Import Agent 7.0.2 

• Integration Express-

H.T.E 7.0 

• Snapshot 7.0.3 

• WebLink 7.0.5 

• Workflow 7.0 

• Toolkit 7.2.1 

Using versions in Laserfiche 7.2 
Versions in Laserfiche allow you save modifications to a document 

as a new, related document. When you create a new version of a 

document – either by saving or importing a modified existing 

document as a new version or by linking one existing document to 

another – Laserfiche creates a version group. Both the original 

document and the new document are considered versions of the 

same document within that version group. Laserfiche keeps track of 

the date the new version was created, the user who created the 

version, and the optional comments that can be set when a new 

version is created or linked; you can use this information to help 

you track modifications to a document. 

 

Why Use Versions? 
• Prevent information loss. Creating a new version of a 

document does not overwrite existing versions of the 

document. It simply adds another document to the version 

group. The original document remains untouched. This allows 

you to review the previous version, or return to the older 

version if you decide not to keep the changes.  

• Maintain different versions for different purposes. You may 

wish to keep different versions of a particular document for 

use in different circumstances. For instance, you might want 

to format a particular report differently to meet the 

requirements of different recipients. You could use a version 

group to create and keep track of different versions of the 

report.  

• Ease of retrieval. Laserfiche 7.2.1 and up allow you to choose 

– in the Browse options and in the Versions search – to 

display only the most recent versions of documents. If you 

need to keep multiple revisions of a document – for 

reference purposes, or for compliance – you can use versions 

to display only the most recent by default, and therefore to 

make your folders and searches more manageable.  

 

Using Security to Enforce Versioning Policy 
You may decide that you want your users to always save changes to 

an electronic document as a new version rather than overwriting the 



existing document. You can enforce this policy using Laserfiche 

entry access rights. Saving a document as a new version requires 

the Create Document right, and saving the changes to the existing 

document requires the Modify Contents right. Therefore, you can 

ensure that users will always save changes to electronic documents 

as new versions by denying the Modify Contents right for that 

document but allowing the Create Document right. 

 

Copy a Selection from a Laserfiche Image 
In Laserfiche 7.1 and later, you can copy all or part of a Laserfiche 

image file. This allows you to quickly copy a portion of an image into 

another document – for instance, to copy a piece of an image for 

review into an email, or to copy a section of text into a Word 

document directly from the image. Additionally, if the image has 

been OCRed, any text that is associated with that section of the 

image can be copied as text into a text application. 

 

When the copied selection is pasted into an application, that 

application will be able to automatically determine the format in 

which it should be pasted. For instance, if you paste into a graphics 

program such as Paint, the selection will paste as an image; if the 

selection has OCRed text, and you paste it into a plain text editor 

such as Notepad, it will paste as text. You can also paste the 

selection into a template field or sticky note on the document, 

although there is nowhere in Laserfiche that can accept the copied 

image selection itself.  

 

Many applications will allow you to paste as either format: Word will 

automatically paste as text, but if you go to the Edit menu and 

choose Paste Special, you can elect to paste it as a bitmap image. 

Additionally, if the selection has not been OCRed, it will 

automatically paste into applications that support text and images 

(such as Word) as an image. 

 

Furthermore, the selection will be pasted as whole words rather 

than leaving dangling letters where the selection cuts across a word. 

When part of a word is selected, the entire word will be copied if at 

least half of it is within the selection box. If less than half of the 

word is within the selection box, none of it will be copied. 

 

To copy a selection from an image 

1. Within the Laserfiche Client 7.1 or 7.1.1, select the file you 

wish to copy from. Open it by double-clicking or by selecting 

Open from the File menu. Note that the document must be 

OCRed if you wish to be able to paste it as text.  

2. Use the pointer to select a region of the image. Click and 

drag to draw a box around the area you wish to copy.  

3. Copy the selection. You can do this by selecting Copy from 

the File menu, by right-clicking and choosing Copy, or by 

pressing CTRL-C.  

4. Open the application in which you wish to paste the 

selection. Note that the selection cannot be pasted anywhere 



within Laserfiche as an image, although text can be pasted 

into Laserfiche text files, template fields, sticky notes, or 

other text-based sections of the document.  

5. Paste by pressing CTRL-V, or by selecting the Paste 

command within the application. 

 

Tech Tip: Customizing a Laserfiche 7 Client Shortcut  
You can sutomize the desktop shortcut to the Laserfiche Client 7 in 

several ways: to automatically select a repository, to automatically 

use Windows Authentication to log you in to a repository or to 

launch the Client as a Viewer. These customizations allow users to 

access their repository immediately, just by clicking an icon.  

 

Customizations to the Laserfiche Client 7 shortcut use command line 

flags, which can be added to the Target option of the shortcut's 

properties dialog. To modify the option, right-click the shortcut to 

the Laserfiche Client and select Properties. Select the Shortcut tab. 

In the Target option, you will see a line similar to the following: 

 

C:\Program Files\Laserfiche\Client\LF.exe  

 

To customize the shortcut, you can modify the target with the 

following flags: 

 

C:\Program Files\Laserfiche\Client\LF.exe -L"RepositoryName" 

where RepositoryName is the name of the repository you want to 

automatically log in to. This flag automatically loads the repository 

in question and bring(s) up the login dialog. 

 

C:\Program Files\Laserfiche\Client\LF.exe -L"RepositoryName" -U 

This flag automatically loads the repository and attempt to log the 

current Windows user in to the repository using Windows 

Authentication, so you can use Windows Authentication to go 

straight into the repository just by clicking the icon. 

 

C:\Program Files\Laserfiche\Client\LF.exe -L"RepositoryName" –U –

V 

This automatically logs you in using a read-only connection, and 

therefore using a read-only license. This feature was added in 

Laserfiche 7.2 and is effectively the same as selecting the Use a 

read-only connection box on the Client log in screen. 

 

These shortcut modifications can be very convenient for users. 

Since most users work with only one repository, they can use this to 

bypass the repository selection screen, which is not relevant for 

them, and log straight in. Even users who do use multiple 

repositories may find it more convenient to create multiple icons 

and use them to log in directly to each repository rather than 

selecting from a list. Finally, users who sometimes want to use 

Laserfiche in a read-write context and other times in a read-only 

context can create a couple of shortcuts and use those to quickly 

access the repository in the manner they choose. 



 

Search results in the Client or Web Access to only show the 
newest document version  
To help with project collaboration there is a search option that will 

limit results to only the most recent version available in both the 

Laserfiche Client and Web Access. To do this, choose Version as the 

search type from the Customize Search drop-down list. One of the 

options is a checkbox for ‘Limit search to latest versions’ 

(screenshot below). With this selected, you can run a search on any 

other criteria and only have the latest version show up in search 

results. Please note that documents that have never been versioned 

will also appear in the results.  

 

 
 
Performance Tips 



Logging In 

The Laserfiche Client may be slow to load your list of available 

repositories, due either to network issues or to a large number of 

repositories. If this is the case, you can turn off network scanning 

and simply attach your repository directly. In Laserfiche 7.2 and up, 

you can do so by right-clicking in the repository selection menu and 

selecting Scan Network for Repositories to clear the selection. You 

will then need to click the Attach button and manually provide the 

server and repository name. From then on, the Client will display 

this repository without scanning for others. 

 

Columns in the Administration Console 

As in the Laserfiche Client, you can choose which columns to display 

in the Laserfiche Administration Console. In this case, you would 

select the node you want to modify, and select Add/Remove 

Columns from the View menu. If you want to display no columns, 

you can do so by opening the View menu and changing the display 

type from Details to List.  

This option is particularly useful in the Volumes node. When you 

view the Volumes node in Details format, it will attempt to perform 

the volume size calculation for each volume. If you have very large 

volumes, or hundreds of volumes, this can take a long time and 

result in significant delay in opening this node. Changing the display 

time to List resolves this problem. 

 

Metadata 

While metadata can make it easy for users to quickly locate 

documents they need, too many different metadata elements can 

both slow performance and make it difficult for users to determine 

which metadata item they should use. Whenever a list of metadata 

items is displayed – for instance, in the template selection list – the 

values must be retrieved from the server. If the number is very 

large (for instance, if there are hundreds of templates), this can be 

a very slow process. A smaller number of templates, tags and links 

will make the metadata dialogs load faster, and will also make 

searching faster and more efficient. 
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Contact Info Our Partners 



877.790.1600 
Web: www.ecsimaging.com 

Sales Inquiry:  

sales@ecsimaging.com 

Tech Support: 

support@ecsimaging.com 

 
Locations 
Southern CA 
3720 Sunnyside Dr. Ste.200 

Riverside, CA 92506 

Tel: 951.787.8768 

Fax: 951.787.0831 

 

Northern CA 
4737 Imhoff Pl Unit 1B 

Martinez, CA 

Tel: 925.370.2456 
 

Our Services 
• Scanning Services 

• Microfiche/Film/Aperture Card 

Conversions 

• Hosted WebLink 

• Custom Programs: Case# Generator, 

Mug Shot Capture, Six-Pack Creator 

• ECS Integration Library Tool 

• Custom Integrations: 

ESRI, Permits Plus, CRW, H.T.E., 

Navision, Eden, Munis, Oracle, 

DataTel, Digital Recorder Importer 

• Fax Server Solutions 

Software  

 
Document Management Software 

 

Integrations 

 
Agenda Manager Integration 

 
 

 
ESRI Integrations 

 
 

 
Data Encryption 

 
 

 
Court Case Management Integration 

 
 

 
Check Scanning & Remittance 

processing Integration 

 

Kofax Product Suite 

 
Ascent & Advanced Forms Processing 

 

 
Virtual ReScan 

 

 
LiveCycle Barcoded Forms 

 

 
Fax Server Solution 

 
 

Scanners 

 
Elite Channel Partner  

 

 
Premier Partner  

 

 
E-size Map Scanners 

This newsletter is emailed exclusively to ECS Imaging, Inc. customers only. 

If you do not wish to receive an email copy, just reply to this email to let us know. 

We also post a copy on our website http://www.ecsimaging.com/news_newsletters.php. 

 


